# Table of Contents

- **Introduction** .......................................................................................................................... 3
- **1.0 System Overview** ............................................................................................................... 4
- **2.0 Software & Drivers** .......................................................................................................... 6
- **3.0 "TRACS Acquire"** ............................................................................................................ 7
  - 3.1 The Thermal IR Camera Interface ...................................................................................... 9
  - 3.2 The RGB Camera Interface .............................................................................................. 11
  - 3.3 Prep: Equipment ................................................................................................................ 13
  - 3.4 Prep: Project/Test File Setup ........................................................................................... 14
  - 3.5 Prep: Camera Focus & Image Adjustment ......................................................................... 15
    - 3.5.1 Thermal IR Camera: Focus & Image Adjustment ..................................................... 16
    - 3.5.2 RGB Camera: Image Adjustment ............................................................................. 18
  - 3.6 Collecting & Archiving Imagery ....................................................................................... 19
- **4.0 "TRACS Process"** ............................................................................................................ 20
  - 4.1 Pre-Processing "Preview" Imagery ................................................................................... 23
  - 4.2 Navigating & Reviewing Imagery in "TRACS Process" .................................................. 24
  - 4.3 Enhancing the Thermal IR Image Channel ....................................................................... 25
  - 4.4 Enhancing the RGB Image Channel .................................................................................. 28
  - 4.5 Defining Your "Area of Interest (AOI)" ........................................................................... 29
  - 4.6 Processing a Full-Resolution Mosaic .............................................................................. 30
  - 4.7 Classification Using the Thermal IR Image Channel ....................................................... 31
- **5.0 File Maintenance - Saving "Processed" Mosaics** ............................................................... 33
  - 5.1 Re-opening PreviouslySaved Mosaics .......................................................................... 34
  - 5.2 Opening TRACS Image Data Files on Another Computer ............................................ 35
  - 5.3 Conserving Hard Disc Recording Space .......................................................................... 36
Introduction

The main purpose of this system is to allow users of the Ohmsett facility to make quick, accurate measurements of the tank surface area covered by water, ice and oil. The imaging system is a customized adaptation of Ocean Imaging Corp.'s “Tactical Rapid Airborne Classification System” (TRACS) used for aerial mapping of oil spills at sea. The most important component is a very sensitive thermal IR camera which is used to separate (with custom-designed software) ice, water and oil of several different thicknesses based on their thermal emittance differences, and instantly compute the total area occupied by each class within a user-defined area of interest (i.e. portion of the imaged tank).

The system is designed to be mounted vertically on the Ohmsett tank's existing bridge crow’s nest, viewing the tank on the North side of the bridge. It can be used to either image a small portion of the tank next to the bridge while stationary, or image a longer portion of the tank while the bridge is moving. The custom software is set to allow the creation of a seamless multi-image frame mosaic when imagery is collected while the bridge moves at 1.0 kn speed. All imaging should be done with the bridge moving in the south-to-north direction.

Since petroleum substances have a lower emissivity than water, thin oil layers will appear cooler than surrounding water. Crude and IFO oil layers thicker than approximately 0.07mm will appear noticeably warmer than surrounding water under sunny or thin cloud conditions (even in winter) because they trap and re-emit solar heating. Ice will appear cooler than both water and oil. It is thus possible to separate water, ice, and thin and thick oil layers into classes based on their different temperature ranges. Note that the thermal images do not detect sheen and rainbow colored very thin oil films. The "TRACS Process" application allows these classes to be created interactively immediately after the original data are collected using the "TRACS Acquire" application. The area occupied by each class is calculated and displayed during the interactive process.

The original image data as well as the created color and thermal mosaics and classification image products can be saved both as JPEG images and as GIS-compatible files. The area classification statistics are also saved as part of this process.

Although designed for oil-in-ice work, the system can be used for other purposes. For example, since thermal imaging does not penetrate the water column, thermal images can be used to monitor the effectiveness of dispersants on floating oil: initially the oil will be distinctly visible in the images, but as the dispersant is applied and portions of the oil slick start dispersing into the water column its thermal signature will decrease, until no signature is left if the dispersant application was fully effective. Other uses of the system include monitoring of oil thickness distributions in the tank, and creating (by imaging from a moving bridge and mosaicking the color data) a full-view of tank setups or equipment that could not be easily photographed with a still camera.
### 1.0 System Overview

#### Components and Hardware Connections

<table>
<thead>
<tr>
<th>P/N</th>
<th>MFTR</th>
<th>COMPONENT / SUB-COMPONENT</th>
<th>MODEL</th>
<th>PDF</th>
<th>CONNECTS TO:</th>
<th>QTY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Jenoptik</td>
<td>THERMAL IR CAM</td>
<td>IR-TCM 1024</td>
<td><img src="#" alt="PDF" /></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wide-Angle Lens</td>
<td>15mm (1.0/15)</td>
<td></td>
<td>Laptop Ethernet Port</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Jenoptik</td>
<td>Data Cable</td>
<td></td>
<td></td>
<td>Power Strip / Extension Cord</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Power Supply Cable / Transformer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P/N</th>
<th>MFTR</th>
<th>COMPONENT / SUB-COMPONENT</th>
<th>MODEL</th>
<th>PDF</th>
<th>CONNECTS TO:</th>
<th>QTY</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>JAI</td>
<td>RGB CAM</td>
<td>ATL-200</td>
<td><img src="#" alt="PDF" /></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shielded Power Supply Cable / Transformer</td>
<td>PD12-UUP</td>
<td></td>
<td>Power Strip / Extension Cord</td>
<td>1</td>
</tr>
</tbody>
</table>

---

**Jenoptik Thermal Cam**

**JAI RGB CAM**
<table>
<thead>
<tr>
<th>2.2</th>
<th>Audio-Video Supply</th>
<th>CameraLink Data Cables</th>
<th>POMCLPD5-0.3-PR</th>
<th>2.3 Pleora CL-USB 3</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.3</td>
<td>Pleora</td>
<td>iPort CameraLink to USB 3.0 Ext Frame Grabber</td>
<td>CL-U3M-IND</td>
<td>2.4 USB 3.0 Extension Cable</td>
<td>1</td>
</tr>
<tr>
<td>2.4</td>
<td>Cable Matters</td>
<td>USB 3.0 Type A Male to Female Active (Extension) Repeater Cable 10M (32.9 Ft)</td>
<td>B00DMFFL2W</td>
<td>2.5 Standard USB 3.0 Cable</td>
<td>1</td>
</tr>
<tr>
<td>2.5</td>
<td>(Any)</td>
<td>Standard USB 3.0 Cable</td>
<td>Acquisition Laptop</td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>
### 2.0 Software & Drivers

If a new acquisition laptop is required, please perform installation steps in the following order using the links below to download software and drivers.

If you are reading a paper copy of this document, please go to this directory to download files: [http://www.oceani.com/TRACS-Ohmsett](http://www.oceani.com/TRACS-Ohmsett)

**Note:** A password and login will be required for download. Please enter the following:

- **Password:** TRACS
- **Login:** Ohmsett

1. Install either the 32 or 64 bit Pleora iPort CameraLink to USB 3.0 Driver (depending on your system).

<table>
<thead>
<tr>
<th>Download</th>
<th>Pleora iPort CameraLink to USB 3.0 driver (32 bit)</th>
<th>Pleora iPort CameraLink to USB 3.0 driver (64 bit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download</td>
<td>ebus_sdk_32-bit.4.0.5.3150.exe</td>
<td>ebus_sdk_64-bit.4.0.5.3150.exe</td>
</tr>
</tbody>
</table>

3. **Restart your computer.**

4. Run the "TRACS Software Installer" (Both "TRACS Acquire" & "TRACS Process" will be installed)

<table>
<thead>
<tr>
<th>Download</th>
<th>TRACS Acquire / TRACS Process Installer</th>
<th>TRACS-Ohmsett_Installer.exe</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download</td>
<td>TRACS-Ohmsett_Installer.exe</td>
<td>TRACS-Ohmsett_Installer.exe</td>
</tr>
</tbody>
</table>

5. Run the following Windows Runtime File Installer

<table>
<thead>
<tr>
<th>Download</th>
<th>Windows Runtime</th>
<th>vcredist_x86_2005.exe</th>
</tr>
</thead>
</table>
3.0 "TRACS Acquire"

Open: “TRACS Acquire.”

Thermal IR Camera Power Status Indicator
1. A "GREEN" light indicates TRACS Acquire reads an "ON" power status. A "RED" light indicates an "ERROR" status.

RBG Camera Power Status Indicator
2. A "GREEN" light indicates TRACS Acquire reads an "ON" power status. A "RED" light indicates an "ERROR" status.

Setup Project/Test (F2)
3. Click this button or the F₂ keyboard shortcut to Setup Your Project/Test/Operator names.

Start/Stop Recording (F8)
4. Click this button or the F₈ keyboard shortcut to START & STOP recording.

RGB/IR Tabs Toggle (F4) Button
5. Click this button or the F₄ keyboard shortcut to toggle between the RGB Camera and Thermal IR Camera image adjustment / focus tabs.
6. **Exit Application (F10)**
   Click this button or the F10 keyboard shortcut to exit "TRACS Acquire."

7. **IR Camera Focus / Image Adjustment Tab**
   Click this tab to show and access the Thermal IR camera focus / image adjustment options.

8. **RGB Camera Image Adjustment Tab**
   Click this tab to show and access the RGB color camera image adjustment options.

9. **Status Bar**
   Watch the Status Bar to ensure increasing frame-count while recording as well as monitoring remaining available disk space.
3.1 The Thermal IR Camera Interface

The "TRACS Acquire" Interface and image adjustment options for the Thermal IR camera.

**RGB Camera Image Adjustment Tab**
Click this tab to show and access the RGB color camera image adjustment options.

**IR Camera Focus / Image Adjustment Tab**
Click this tab to show and access the Thermal IR camera focus / image adjustment options.

**Max Low-Temp Cut-off Entry Field**
Use this field to enter a lowest-temp cut-off value for the Thermal IR image acquisition temperature range which corresponds to the resulting greyscale range between the high and low temp parameters entered.

**Max High-Temp Cut-off Entry Field**
Use this field to enter a highest-temp cut-off value for the Thermal IR image acquisition temperature range which corresponds to the resulting greyscale range between the high and low temp parameters entered.

**Auto Image**
Click this button after each re-start (and intermittently during tests) to "auto-enhance" the greyscale range between the lowest and highest temperatures seen – thus increasing contrast.
6. Manual Ring Focus - Counterclockwise
   Click one of the left/right arrow buttons to manually make incremental adjustments to the camera's focus (analogous to rotating the camera's focus ring).

7. Auto Focus
   Click this button to automatically focus the lens of the Thermal IR camera over some sharply defined objects in the tank. This must be done each time you start a Project.

8. Manual Ring Focus - Clockwise
   Click one of the left/right arrow buttons to manually make incremental adjustments to the camera's focus (analogous to rotating the camera's focus ring).
3.2 The RGB Camera Interface

The "TRACS Acquire" Interface: Image adjustment options for the RGB camera.

1. Thermal IR Camera Power Status Indicator
2. RGB Camera Power Status Indicator
3. Start / Stop Recording (F8)
   - Click this button or the F8 keyboard shortcut to START or STOP recording.
4. Setup Project/Test Name (F2)
   - Click this button or the F2 keyboard shortcut to Setup Your Project/Test/Operator names.
5. Toggle (F4) Button
   - Click this button or the F4 keyboard shortcut to toggle between the RGB Camera and Thermal IR Camera focus / image adjustment tabs.
6. Exit Application (F10)
   Click this button or the F10 keyboard shortcut to exit "TRACS Acquire."

7. IR Camera Focus / Image Adjustment Tab
   Click this tab to show and access the Thermal IR camera focus / image adjustment options.

8. RGB Camera Image Adjustment Tab
   Click this tab to show and access the RGB color camera image adjustment options.

9. RGB Camera Exposure Control Slider
   Use this slider to adjust the camera's exposure (lightness and darkness).
3.3 Prep: Equipment

Camera Power Pre-Check - Physical

With POWER to units switched "ON" at power strip, verify the respective unit power indicator lights:

<table>
<thead>
<tr>
<th>Item #</th>
<th>COMPONENT</th>
<th>POWER Indicator Light Location</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>THERMAL CAM</td>
<td>Power Light</td>
<td>SOLID GREEN (after a short blinking initialization)</td>
</tr>
<tr>
<td>2.0</td>
<td>JAI RGB CAM</td>
<td>Power Light</td>
<td>SOLID GREEN</td>
</tr>
</tbody>
</table>

Camera Power Pre-Check - TRACS Acquire Software

Double click the "TRACS Acquire" desktop shortcut icon to start the acquisition software.

After a short initialization period, VERIFY solid "GREEN" unit-indicator light status’ within the "TRACS Acquire" software interface.

If either of the indicators are "RED," power camera(s) OFF, and then power back ON.
3.4 Prep: Project /Test File Setup

In “TRACS Acquire,” click either the “Setup” button, or the F2 keyboard shortcut.

When the "Setup" dialog window opens, enter values for the following data parameter fields:

*Project Name*
*Test Name*
*Operator Name* (Recommended: Enter operator's initials in all CAPS)

(The "Next Run #" field entry is automatically advanced after the recording of each run is terminated.)

***Very Important Naming Rules:*** The following characters must NEVER be used in Flight and Project Names:

- NO Spaces
- NO Periods
- NO Hyphens
- NO Underscores

Note: Grayed-out/inaccessible data parameter fields do not need to be adjusted for the purposes of use at the Ohmsett facility.
3.5 Prep: Camera Focus & Image Adjustment

The "TRACS Acquire" software shows a Work View of the imagery from either the IR (Thermal), or RGB camera in real time. Until you click the "START" (recording) button, however, no data is actually archived to the disk. You can use the system to view the tank in real-time without archiving data.

To toggle between the IR and RGB camera views:

   Click either the "Toggle" button, or the $F4$ keyboard shortcut.

Adjustments will need to be made to each camera individually.
3.5.1 Thermal IR Camera: Focus & Image Adjustment

Click either the "Toggle" button, the keyboard shortcut, or the "IR Camera" tab to toggle to the "IR Camera" image adjustment options tab.

First, focus the Thermal IR camera.

To focus the thermal image:

Click the "Auto Focus" button to achieve focus each time you start a Project. You need some sharply defined objects in the image for this to work such as the edge of the tank or floating booms. The thermal camera cannot focus on open water. If "Auto Focus" fails to focus the camera correctly, use the left/right arrow buttons to manually make incremental adjustments to the camera's focus (analogous to rotating the camera's focus ring clockwise or counter-clockwise).

Next, enhance the Thermal IR camera.

To enhance the thermal image:

Click the "Auto Image" button. This will "auto-enhance" the greyscale range between the lowest and highest temperatures seen – thus increasing contrast. You may need to click "Auto Image" 2 - 3 times to achieve the best contrast results.

If "Auto Image" fails to provide a good contrast/brightness range, you can manually enter the desired temperature range values in the "Low" and "High" temperature cutoff fields.
Note: The Thermal camera does not retain greyscale or infinity settings after shutdown. You must re-perform these steps below after each re-start. Enhancement may also "drift" over time (usually gets darker - especially in cold weather) requiring periodic re-enhancement.
3.5.2 RGB Camera: Image Adjustment

The RGB camera does not need "focusing" per se (the lens is set at "infinity"), but rather requires "image enhancement."

The RGB camera lens' F-stop setting also does not need to be adjusted. The lens F-stop has been permanently fixed at ~f7 for purposes at Ohmsett.

Click either the "Toggle" button, the F4 keyboard shortcut, or the "RGB Camera" tab to toggle to the "RGB Camera" image adjustment options.

To adjust the exposure of the RGB camera image:

Since land areas are usually much brighter than water, you should adjust exposure over the water areas that you will be imaging.

Slide the "Exposure" slider until you feel you have visually achieved optimum image-enhancement.

Important Note: Unlike adjusting the brightness/contrast appearance of the Thermal IR camera (which does not affect the actual data collection), adjustments made with the RGB "Exposure" slider actually alter the collected image data. Hence, if the RGB image appears too dark or too bright, the collected data will have the same appearance.
TRACS-Ohmsett User Guide

3.6 Collecting & Archiving Imagery

Once you have completed the following preparations, you will be ready to collect and archive imagery for processing using "TRACS Acquire":

- Verified "green-light" power conditions for both cameras
- IR cam focused
- RGB cam image enhancement levels set for your RGB images

⚠️ **Recording must be done when the bridge is moving northbound only (thermal camera forward) at exactly 1kn speed!** The calculations built-into TRACS-Ohmsett software have been gauged for a travel speed of 1kn.

To collect and archive imagery:

Click the "Start (F8)" (recording) button, or the F8 keyboard shortcut.

⚠️ VERIFY an ascending image frame-count (display located in bottom status bar) every 8-15 seconds (depending on bridge speed of 1kt/hour).

Remember to click the "Stop (F8)" (recording) button, or the F8 keyboard shortcut to STOP recording when you are done collecting!

Note: Each time you click to "STOP" (recording), the Run Counter automatically advances the titling of the next Run number by 1 incrementally (Run1, Run2, Run3 etc.).

To "Process" your acquired imagery, you will now have to open your collected data within "TRACS Process."
STOP RECORDING in "TRACS Acquire" before moving on to "TRACS Process!"

Click the "Stop (F8)" button, or the F8 keyboard shortcut to STOP recording.

Minimize: "TRACS Acquire."

Then Open: "TRACS Process."

The TRACS Process Interface

- Project / Test Work File Indicator
- Select Test
- Select AOI
- Process
- Thermal IR Class Color Keys

Status Bar
Filters Option
Min/Max Option
Std Dev Option

Project / Test Work File Indicator

**Project: SBDemo**
**Test Name: Flight1**
Select Test
Click this button to select a Project / Test / Run File to work on.

Select AOI
Click this button to select a cropped "Area of Interest (AOI)" in your open Project / Test / Run image.

Process
Click this button to "process" a high-resolution image mosaic from either an entire Project / Test image area, or a cropped image area (selected AOI).

Thermal IR Class Color Keys

Status Bar
Watch the TRACS Process' Status Bar for various messages and file information.
Filters Option

With a Project / Test / Run "Preview" or "Processed" image open, check the "Filters" checkbox to enable access to the "Std Dev" and "Min/Max" image adjustment control options.

Min/Max Option

With a Project / Test / Run "Preview" or "Processed" image mosaic open, and the "Filters" checkbox enabled, check the "Min/Max" radio button to access manual date entry fields for setting high/low temperature range cut-offs (Thermal IR image channels only).

Std Dev Option

With a Project / Test / Run "Preview" or "Processed" image open, and the "Filters" checkbox enabled, check the "Std Dev" radio button to access and toggle through 5 "Standard Deviation" preset enhancement strategies for both RGB and Thermal IR image channels.
4.1 Pre-Processing "Preview" Imagery

Selecting which image set to process:

Click the "Select Test" button, or from the main menu, select "File > Select Test."

To view/process a prior Project or Test collection run:

Click the arrow on the "Project" pull-down menu and select a prior project from the pull-down list.

Click the arrow on the "Test Name" pull-down menu, then select a Test associated with the Project Archive you selected.

From the "Runs" options, select the Runs associated with that Project / Test Archive you want to process.

Click the "Use Selected" button.

To automatically choose the "latest" Run collected:

Click the "Use Latest" button, or from the from the "Runs" options, select the Run # associated with that Project / Test Archive you want to process.

Click the "Use Selected" button.

A sub-resolution preview mosaic of the selected imagery will open. Sub-resolution preview mosaics can be used as quick, reasonably accurate data sets for finding actionable oil targets, the thickest oil locations, etc. The Preview Images will likely need to be enhanced. Zoom and Pan features can be used.

For full-resolution, fully-processed data you will first need to define an Area Of Interest (AOI).
4.2 Navigating & Reviewing Imagery in "TRACS Process"

Viewing "Preview" or "Processed" image mosaics:

Click the header tab of each "Processed" full-res image mosaic tab to toggle between processed mosaics.

To delete "Preview" or "Processed" mosaics:

Click the red x on the mosaic tab.

To toggle viewing between IR (Thermal) and RGB (color) image views:

Click the "RGB Color or Visible" toggle button.

Zoom In / Out:

Using a mouse: Use either a trackball or scroll-wheel to zoom in/out over the image area.
Using a touch-screen computer: Use your fingers to spread-to-zoom or pinch-to-contract the image view.

Pan:

Using a mouse: While holding the mouse button down, click and drag (pan) the image through the window-view area
Using a touch-screen computer: Drag the image through the window-view area with your finger.
4.3 Enhancing the Thermal IR Image Channel

The process of enhancing the imagery can be tricky, especially if there are very contrasted bright/dark or warm/cold features in the scene. Enhancing requires practice. Generally it is easier to work on (enhance) a fully processed image set when the Area Of Interest represents a smaller subset of the entire collected data region.

Recommended First-Approach Method of Enhancing the Thermal IR Image Channel:

There will generally be a very large temperature range in the thermal images, especially in the Preview Images which include part of the bridge and tank edge in the image area. The fastest enhancement method is to follow the sequence of steps below:

1. **First**, check the "Filters" check-box, then check the "Min/Max" radio button to access the preset-temperature range toggle options and the Min and Max temperature range sliders. The "Min/Max" radio button is the default image filter option because when used as described below, it is the quickest method to thermal image channel enhancement.

2. Adjust the Min/Max temperature range low/high cutoff values via the following methods until detail becomes sufficient:

   Click the center temp button to toggle through several preset temperature ranges representative of the ocean water most commonly encountered.

   When one of the preset options produces the desired enhancement, further refinement can be made by manually adjusting the low and/or high temp settings sliders. The temperature of any point or feature in the image can be obtained by moving your cursor around features of interest and noting the temperatures reported in the Status Bar. These readings help you find the temperature range of interest.
With those temperature values in mind, the "Min / Max" sliders can be manually adjusted to bring out the most detail in the image features.

To micro-incrementally adjust the low and high temp cutoff values:

Click on either the low or high "Min/Max slider" to highlight it.

With the slider highlighted, use the Left (-) or RIGHT(+) arrow keyboard keys to micro-adjust the temperature setting in .10 degree increments.

3. Once sufficient image detail has emerged, further fine-tuning can be done via the Brightness and Contrast "Image Adjustment" sliders:

- First, use the "Contrast" slider to enhance the features of interest.
- IF additional adjustments are necessary, use the "Brightness" slider.

Using the "Standard Deviation" Filter to Enhance the Thermal IR Image Channel:

The Standard Deviation ("Std Dev") filter is another enhancement option. It tends to NOT work for the Preview image mosaics (due to the prolific temperature range caused by the inclusion of the tank edge in the image area) but can be useful on fully Processed mosaics where an AOI selection has narrowed the range. Choose from a range between 1 and 5 standard deviations.

Check the "Filters" checkbox to access the "Std Dev" or "Min/Max" image adjustment filters.
Use the Standard Deviation slider to select from 5 standard deviation levels of image brightness. *(Note: Preset options 1 or 2 usually produce the best results.)*

If you “mess-up” the image to the point you cannot get any good enhancement, it is faster and easier to simply reload it by:

- Closing that "Processed" image tab (Click that tab's red 
  
- Once you have returned to the "Preview" image, your existing AOI selection will still be defined by a red outline.

- Click the “Process” button to generate a new "Processed" AOI image to operate on.
4.4 Enhancing the RBG Image Channel

The process of enhancing the imagery can be tricky, especially if there are very contrasted bright/dark or warm/cold features in the scene. Enhancing requires practice. Generally it is easier to work on (enhance) a fully processed image set when the Area Of Interest represents a smaller subset of the entire collected data region.

To enhance RGB Color Imagery:

1. First, use the “Contrast” slider to enhance the features of interest.
2. IF additional adjustments are necessary, use the “Brightness” slider.
   If these adjustments don't work, it means there are features within the mosaic with "outlying", i.e. extremely bright and/or dark values.

To further enhance an extremely contrasted RGB image:

Check the “Filters” checkbox to enable the "Std Dev" image editing option.

(The "Min/Max" filter is not applicable to RGB image channels.)

Use the Standard Deviation slider to select from 5 standard deviation levels of image brightness. (Preset options 1 or 2 usually produce the best results.)

Further fine-tuning can be done further via the Contrast and Brightness "Image" adjustment sliders above.

If you “mess-up” the image to the point you cannot get any good enhancement, it is faster and easier to simply reload it by:

Closing that "Processed" image tab (Click that tab's red 

Once you have returned to the "Preview" image, your existing AOI selection will still be defined by a red outline.

Click the "Process" button to generate a new "Processed" AOI image to operate on.
4.5 Defining Your "Area of Interest (AOI)"

Most often you will want to select only a portion of a larger Project/Test/Run mosaic Preview to work on. This is your "Area of Interest (AOI)."

"Processed" image mosaics are "full resolution" which means each pixel represents an area of 46.24 mm (i.e. 6.8 x 6.8 mm).

To create a bounding box selection defining your AOI:

Click the "Select AOI" button. The button should highlight "RED."

Place the cursor crosshairs at a corner-point of your AOI bounding box.

While keeping the left-mouse button depressed, click-and-drag a bounding box defining your AOI. (Using a touch-screen computer, this can be done with your fingertips.)

The resulting AOI boundary will be defined by a red boundary box.

To draw a new AOI selection:

If you don’t like the defined AOI, simply click the "Select AOI" button again and re-draw a new AOI selection as described above.
To process a full-resolution image mosaic of your Preview image or from an AOI selected from your Preview image:

With your “Preview” image open, and an AOI selection defined (optional), click the “Process” button.

The “Process Test” dialog window opens, note that all parameter options will be preset-locked with the exception of "Overlap Priority."

The two Overlap Priority methods represent the mosaic-build "stacking order" of the collected image frames - either first-to-last or last-to-first. One of Overlap Priority settings options usually produces better results than the other based on sun glint geometry and other factors present at the time of data-collection. Most often you will want to process and review the results from both stacking-order methods in order to select the best resulting image mosaic.

The default Overlap Priority is the stacking order that was used for the last processed mosaic Run - "Previous Scene."

Select the radio button of the desired image Overlap Priority.

Click the “Run” button and wait for a "Processed" image mosaic to appear.

You will now have a “Preview” tab, and one to several tabs titled “Processed.” The "Processed" tabs are the full-resolution AOI images created each time you clicked “Run” to process an image mosaic.
4.7 Classification Using the Thermal IR Image Channel

One of the most important features in "TRACS Process" is the "Thermal Classification Color Key." This feature allows the assignment of color keys to a specified lowest-to-highest "cut-off" temperature range per class. The Color Sliders are ONLY used for TIR/temperature image channels. Using thermal temperature ranges, the user can classify different targets (i.e. ice, water, thin oil, thick oil).

To classify targets according to designated high/low temperature range cutoff values for that class:

With the Processed mosaic image open you want to work on, and your Work View toggled to "Thermal IR," check the checkbox of a "Color Key" to which you want to assign a specified temperature range in your classification results.

NOTE: This operation only functions while viewing the Thermal IR image channel.

High/Low cutoff temperatures can be entered either of two ways:

1. Manual entry of numeric temperature data values - type in values and press "Enter" key on your keyboard to view changes.
2. Using the top slider in each color to set the max low temp, and the bottom slider in each color to set the max high temp.

Both methods result in a real-time preview of your adjustments. Repeat the above step for each thermal temperature range you want to Color Key. The total Surface Area of each Color Class within the full Processed mosaic is calculated and shown for each Class Color.

To micro-incrementally adjust the low and high temp cutoff values up or down by .10 degree:

Click on either the low or high "Min/Max slider" to highlight it.
With the slider highlighted, use the Left (-) or RIGHT(+) arrow keyboard keys to micro-adjust the temperature setting in .10 degree increments.

Below is an example of a Thermal IR image with assigned class Color Keys.

<table>
<thead>
<tr>
<th>Temperature Range Assignment</th>
<th>Calculated Coverage Area m²</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>19.6 - 20.6</td>
<td>7.39</td>
<td>Water / Sheen</td>
</tr>
<tr>
<td>0.0 - 17.8</td>
<td>1.55</td>
<td>Ice</td>
</tr>
<tr>
<td>19.6 - 20.0</td>
<td>4.93</td>
<td>Thin Oil</td>
</tr>
<tr>
<td>17.8 - 19.6</td>
<td>12.64</td>
<td>Thick Oil</td>
</tr>
</tbody>
</table>

An example of the accompanying .TXT info file which is saved with a .JPG Classification Image.
5.0 File Maintenance - Saving "Processed" Mosaics

All collected unprocessed image data frames are automatically saved to the Acquisition Laptop hard drive. "Processed" mosaics must be either manually saved or will be deleted when its tab is closed.

To close a tab without saving the "Processed" image mosaic:

Click the red  on the image tab.

To save a mosaic image "Processed" from your AOI:

With the image mosaic tab you want to save selected, from the main menu, select “File > Save As”

You have the option to save the image in the following file formats:

<table>
<thead>
<tr>
<th>File Format</th>
<th>Saves As</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG (*.jpg)</td>
<td>Saves as a .JPG with an accompanying .TXT file describing the temperature range and total area values for each thermal Color Class (if assigned).</td>
</tr>
<tr>
<td>GEOTIFF (*.tif)</td>
<td>Saves both Thermal &amp; RGB Image Channels in one GeoTIFF file.</td>
</tr>
<tr>
<td>Image File (*.bil)</td>
<td>Saves as .bil or bip Image Files accessible by GIS processing software for further analysis.</td>
</tr>
</tbody>
</table>

When the "Save As" dialog window appears, you will likely want to name the mosaic something simpler than the long file name highlighted in blue, so enter a new name, then click “Save.”
5.1 Re-opening Previously Saved Mosaics

To open a previously saved mosaic:

From the Main Menu, select "File > Open > Projects > {Your Project} > {Your Test} > {Your File Name}"

Choose your saved mosaic from the available file list.

Note: It is irrelevant whether you choose to open either the Color (RGB) or Thermal (TIR) file since both image channels will be available for viewing. Use the RGB and Thermal IR toggle button to swap views in any open file.
5.2 Opening TRACS Image Data Files on Another Computer

To open image data from the Acquisition Laptop in the "TRACS Process" application on another computer:

In order to open copied image files in "TRACS Process" on another computer, you must first transfer/copy the image files into the appropriate folder structure so TRACS Process can locate and access the RGB and TIR files respectively:

C:\Users\Public\Documents\TRACS\Projects\{Project Name}\{Test Name}\JAIV-MS3-WAN\RAW
C:\Users\Public\Documents\TRACS\Projects\{Project Name}\{Test Name}\JTCM-TIR-WAN\RAW

If the {Project Name} and {Test Name} sub folders do not already exist under C:\Users\Public\Documents \TRACS\Projects on your new/target computer, they will need to be created prior to copying files from a thumb drive.

Alternatively, you may copy/paste the entire Project or Test folder structure archive from the source computer to a USB thumb drive (or other storage/transfer media) and then copy the files into the appropriate "TRACS Process" file structure location on the target computer.

See Offloading image data from the Acquisition Laptop
5.3 Conserving Hard Disc Recording Space

You **must** intermittently transfer or copy off archived data files to conserve hard disc recording space on the Acquisition Laptop. After copying the files to a portable drive or another computer, delete the original files.

**Off-loading image data from the Acquisition Laptop:**

- Connect a USB thumb drive or other portable drive media to the Acquisition Laptop.
- Copy the desired data to the storage/transport media of your choice.
- All image files are located within your uniquely named "Project" folders and "Test" subfolders, located in:
  - C:\Users\Public\Documents\TRACS\Projects\ folder on the Acquisition Laptop.

  Both the image and header files for the RGB scenes (imagery from the JAI camera) are located in:
  - C:\Users\Public\Documents\TRACS\Projects\{Project Name}\{Flight Name}\JAIV-MS3-WAN\RAW folder

  The image and header files for the Thermal Infrared scenes (TIR imagery from the Jenoptik camera) are located in:
  - C:\Users\Public\Documents\TRACS\Projects\{ProjectName}\{FlightName}\JTCM-TIR-WAN\RAW

*For example*, to transfer data from “Test1” acquired as part of the “CrudeOnIce” Project, the RGB and TIR data would be located in (respectively):

- C:\Users\Public\Documents\TRACS\Projects\CrudeOnIce\Test1\JAIV-MS3-WAN\RAW
- C:\Users\Public\Documents\TRACS\Projects\CrudeOnIce\Test1\JTCM-TIR-WAN\RAW